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Getting Started with 

ArcGIS®

Pro
A Quick Start Guide to downloading, 
installing, and licensing ArcGIS Pro
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Introduction

To work with ArcGIS Pro®, you will need to download and install ArcGIS Pro, then authorize 
ArcGIS Pro. Three license types are available: Named User, Single Use, and Concurrent Use. 
As the default license type, Named User licenses are used in most cases and are managed 
through either your ArcGIS Online organization account or ArcGIS Enterprise portal account. 

The steps to set up Named User licenses require that you either are designated as 
Administrator or have the Manage Licenses privilege in the ArcGIS Online or ArcGIS Enterprise 
portal account being used to manage the licenses. 

The steps to convert Named User licenses to Single Use or Concurrent Use licenses require 
that you have the Take Licensing Action permission in My Esri. 

Troubleshooting FAQ

Additional resources



3

Download and install ArcGIS Pro

1 	 Review the ArcGIS Pro system requirements 
	 Make sure that your machine meets the minimum system requirements. 

2 	 Download ArcGIS Pro 
	 Go to My Esri and download the installation file and any optional setups. To download, 

the user name you signed in with must be connected to your organization with the 
appropriate permissions. If you don’t have appropriate permissions, the option to 
download will not be available to you. If you’ve already installed ArcGIS Pro, go to the 
Authorize ArcGIS Pro section.

	 On the My Organizations tab, click Request Permissions, which will notify your 
administrator to connect your Esri Account to your organization.

	 If you already have permissions, you’ll see the Downloads tab. Click the Downloads 
tab, choose the version of ArcGIS Pro, and click View Downloads.

http://pro.arcgis.com/en/pro-app/get-started/arcgis-pro-system-requirements.htm
https://accounts.esri.com/?redirect_uri=https%3A%2F%2Fmy.esri.com%2F%23%2F
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	 On the ArcGIS Pro page, under Download Components, expand Product 
Components and click Download. 

	 The ArcGIS Pro application is a ~940 MB .exe file. Double-click the downloaded file to 
install it.

	 If you downloaded any optional components, such as ArcGIS Pro Offline Help, install 
ArcGIS Pro first and any optional components afterward.

	 Before using the application, it is necessary to authorize ArcGIS Pro.
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Authorize ArcGIS Pro

	 ArcGIS Pro can be authorized using one of the following methods. Click a link below to 
choose how you would like to authorize ArcGIS Pro for setup instructions:

1.	 Named User with ArcGIS Online organization 
2.	 Named User with ArcGIS Enterprise
3.	 Single Use
4.	 Concurrent Use

1 	 Named User with ArcGIS Online organization
1.	 Log in to your ArcGIS Online organization account. If you have not yet set up the 

ArcGIS Online organization account, see the How to set up an ArcGIS Online 
organization account section.

2.	 From the Organization tab, click MANAGE LICENSES. If you do not see the 
MANAGE LICENSES tab, verify that you are signed in as Administrator or in a role 
with the Manage Licenses privilege. 

3.	 Search for a user, select the user that you want to assign an ArcGIS Pro license to, 
and click CONFIGURE.

4.	 Check the check boxes to assign the ArcGIS Pro license level and extensions for the 
selected user or users and click ASSIGN. 

	 The users you’ve selected can now work with ArcGIS Pro using a Named User 
license through the ArcGIS Online organization account.
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	 In this example, an Advanced license has been assigned to the user name 
ArcGISPro_User. Upon launching ArcGIS Pro, the person with that user name will be 
prompted to sign in:

	 The user’s ArcGIS Online organization credentials are now valid to open ArcGIS Pro. 
The application opens and the user can open a recent project or create a new 
project.

2 	 Named User with ArcGIS Enterprise
	 As an administrator of an ArcGIS Enterprise portal that will provision ArcGIS Pro licenses 

to portal members, you will need to do the following:

	 1.	Configure ArcGIS Pro licenses for your organization
	 2.	Provision ArcGIS Pro licenses in Portal for ArcGIS
	 3.	Connect to the licensing portal in ArcGIS Pro

http://server.arcgis.com/en/portal/latest/administer/windows/configure-arcgis-pro-licenses.htm#ESRI_SECTION1_B534D464350F43FDA277B746F1E6EF36
http://server.arcgis.com/en/portal/latest/administer/windows/configure-arcgis-pro-licenses.htm#ESRI_SECTION1_87DAA797B12D43F199C09A1B993D53D4
http://server.arcgis.com/en/portal/latest/administer/windows/configure-arcgis-pro-licenses.htm#ESRI_SECTION1_4A1E11A6BB4540C68929AB44C0DFEF00
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3 	 Single Use
	 ArcGIS Pro uses the Named User license option by default. To obtain Single Use 

licenses for ArcGIS Pro, go to My Esri and create them by converting Named User 
licenses to ArcGIS Pro Single Use licenses. If you are not sure which licensing option to 
use, refer to the ArcGIS Pro license types help for more information.

1.	 Open a web browser and log in to My Esri with your Esri Account.
2.	 Click My Organizations > Licensing > Convert ArcGIS Pro Named User Licenses.

3.	 Use the Quick Search box and filters to locate the license to convert. After you 
have identified the license you want to convert, follow the steps and guidelines on 
the Convert ArcGIS Pro Named User Licenses page. These steps are summarized 
below.

	 In Step 1: Select License, in the Actions column, click Convert for the license you 
want to convert.

https://accounts.esri.com/?redirect_uri=https%3A%2F%2Fmy.esri.com%2F%23%2F
http://pro.arcgis.com/en/pro-app/get-started/licensing-arcgis-pro.htm
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	 In Step 2: Convert Licenses, click the Quantity arrows to specify the number of 
licenses you want to convert. Click Next.

	 In Step 3: Review, review your settings. If you want to make changes, click Back. If 
you are ready to proceed, click Convert Licenses.

When your licenses are successfully converted, the resultant authorization 
numbers display. These numbers will also be sent to the email address 
associated with your Esri Account.

Optionally, click Export: PDF or Export: Excel to save the numbers in a file.

	 Click View Authorization Summary to view all current licenses.

Optionally, create a provisioning file to avoid entering the authorization 
numbers manually in the Software Authorization Wizard. On the My 
Organizations tab, click the Create New Provisioning File tab on the left 
and complete the steps to create your file.



9

	 4.	Start ArcGIS Pro with a Single Use license.

	 a.	 Start ArcGIS Pro. On the ArcGIS Sign In page, click Configure your  
	 licensing options. 

	 If you are already signed in to ArcGIS Pro with a different license type (like 
Named User), click Project > Licensing > Configure your licensing options to 
bring up the Licensing dialog box.

	 b.	 On the Licensing dialog box, in the License Type drop-down list,  
	 choose Single Use License and click OK.
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	 c.	 Under License Level, select your license level (Advanced, Standard, or Basic).

	 d.	 Click Authorize. The Software Authorization Wizard opens.

	 e.	 In the Software Authorization Wizard, under Authorization Options, 
		  click I have installed my software and need to authorize it. Click Next.

	 f.	 For Authorization Method, click Authorize with Esri now using 
		  the Internet.* Click Next.

	 g.	 For Authorization Information, provide all the information marked with 
		  an asterisk (*). Click Next.

	 h.	 For Authorization Information (continued), provide the correct  
	 information in each drop-down list. Click Next.

	 i.	 For Software Authorization Number, enter the single use  
	 authorization number you generated in My Esri by converting the  
	 Named User license. 

	 j.	 For Authorization Software Extensions, if you are not authorizing extension 	 
	 products, click I do not want to authorize any extensions at this time. Click 

		  Next to start the authorization process.

	 k.	 When the authorization process is complete, click Finish.

*If you have selected the Authorize at Esri’s website or by email to receive your authorization file option on the 
second page of the Software Authorization Wizard (step f), save the generated text file and either upload it to the 
offline authorization tool found within My Esri or send it as an attachment in an email to authorize@esri.com. You will 
then receive an authorization response file (*.respc), which you can use in steps d and e by choosing the option I have 
received an authorization file and am now ready to finish the authorization process. Browse to the authorization 
response file and click Next to complete the software authorization.

https://accounts.esri.com/?redirect_uri=https%3A%2F%2Fmy.esri.com%2F
mailto:authorize%40esri.com?subject=
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	 l.	 On the Licensing dialog box, click OK. You must restart ArcGIS Pro for your 
	 license changes to take effect.

When ArcGIS Pro is launched with a Single Use license, there is no prompt for 
the user to sign in. Instead, the application opens directly and the user can 
open a recent project or create a new project. Notice that in this example, the 
user is not signed in and would need to connect to a portal (ArcGIS Online or 
ArcGIS Enterprise) to access his or her content, the group’s content, and the 
organization’s content in the project. 
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4 	 Concurrent Use
The default ArcGIS Pro license type is Named User. Before Concurrent Use licenses can be 
used with ArcGIS Pro, an administrator must convert Named User licenses to Concurrent Use 
licenses in My Esri.

As an administrator of an organization that has been provisioned with ArcGIS Pro licenses, you 
must complete the following steps to use Concurrent Use licenses. 

1.	 Convert Named User licenses to Concurrent Use licenses.

	 a.	 Open a web browser and log in to My Esri with your Esri Account.

	 b.	 Click My Organizations > Licensing > Convert ArcGIS Pro Named  
	 User Licenses.

	 c.	 Use the Quick Search box and filters to locate the license to convert. After 
	 you have identified the license you want to convert, follow the steps and

		  guidelines on the Convert ArcGIS Pro Named User Licenses page. These 
		  steps are summarized below.

In Step 1: Select License, in the Actions column, click Convert for the 
license you want to convert.

https://accounts.esri.com/?redirect_uri=https%3A%2F%2Fmy.esri.com%2F
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In Step 2: Convert Licenses, click the Quantity arrows to specify the number 
of licenses you want to convert. Click Next.

	 In Step 3: Review, review your settings. If you want to make changes, click Back. 
If you are ready to proceed, click Convert Licenses.

When your licenses are successfully converted, the resultant authorization 
numbers display. These numbers will also be sent to the email address 
associated with your Esri Account.

Optionally, click Export: PDF or Export: Excel to save the numbers in a file.

Click View Authorization Summary to view all current licenses.
 

Optionally, create a provisioning file to avoid entering the authorization 
numbers manually in the Software Authorization Wizard. On the My 
Organizations tab, click the Create New Provisioning File tab on the left 
and complete the steps to create your file.

2.	 Install ArcGIS License Manager.
	 See the Installing the license manager help for details.

	 a.	 Log in to the computer as a user with administrative privileges.

	 b.	 Close all applications on your computer.

	 c.	 Log in to My Esri and choose the License Manager download option. 
		  The license manager will download and run the setup program.

http://desktop.arcgis.com/en/arcmap/latest/get-started/installation-guide/installing-the-lm.htm


14

	 d.	 Follow the instructions on the screen. ArcGIS License Manager lets you
		  choose where you want to install the license manager. On Windows, the 	
		  default installation location is C:\Program Files (x86)\ArcGIS\License10.x
		  \bin. On UNIX and Linux, the default installation location is $HOME/arcgis 

	 /license10.x.

	 e.	 Once you have completed the license manager installation, you can use 
		  ArcGIS License Server Administrator to authorize licenses for the license 
		  manager.

3.	 Authorize Concurrent Use licenses with License Manager.
	 As an administrator of an organization that has been provisioned for ArcGIS Pro, 

you must authorize licenses before the application can be used. Concurrent Use 
licenses are stored and managed in ArcGIS License Manager. After ArcGIS License 
Manager is installed and provisioned with licenses, users can start ArcGIS Pro and 
check out any available license.

	 a.	 In Windows, click Start > Programs > ArcGIS > License Manager > 
		  License Server Administrator. In Linux, you can run License Server 
		  Administrator from the installation location by using the following command: 
		  <installation_path>/arcgis/license10.x/LSAdmin.

	 b.	 In the directory tree, click the Authorization folder.

	 c.	 From the Version drop-down list, select the correct version of ArcGIS Pro.
	

	 d.	 Click Authorize Now to open the Software Authorization Wizard.

	 e.	 Use your Concurrent Use license authorization numbers or provisioning 
		  file from My Esri to complete the steps in the Software Authorization 	
		  Wizard.
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	 f.	 From the ArcGIS License Server Administrator, in the directory tree, click the 	
		  Availability folder. The authorized available licenses are displayed.

	 4.	Start ArcGIS Pro with a Concurrent Use license.

		  After Concurrent Use licenses have been authorized, ArcGIS Pro can be started 
	 with a Concurrent Use license.

	 a.	 Start ArcGIS Pro. On the ArcGIS Sign In page, click Configure your  
	 licensing options. 

	 If you are already signed in to ArcGIS Pro with a different license type (like 
Named User), click Project > Licensing > Configure your licensing options to 
bring up the Licensing dialog box.
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	 b.	 On the Licensing dialog box, in the License Type drop-down list, choose 
		  Concurrent Use License.

	 c.	 Under License Level, select your license level (Advanced, Standard, or Basic) 	
		  and click OK.

	 d.	 Type the name of your license manager. Optionally, type the name of a 
		  backup license manager.

		  The available licenses and extensions are displayed. The core product license 
		  (for example, ArcGIS Pro Advanced) should be checked by default. If you do 
		  not see any licenses, click Refresh.
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	 e.	 In the Licensed column, check the check boxes for any available extension 
		  products you want to use. Click OK. 

When ArcGIS Pro is launched with a Concurrent Use license, there is no 
prompt for the user to sign in. Instead, the application opens directly and the 
user can open a recent project or create a new project. Notice that in the 
example below, the user is not signed in and would need to connect to a 
portal (ArcGIS Online or ArcGIS Enterprise) to access his or her content, the 
group’s content, and the organization’s content in the project. 

As an administrator with access to the license manager (ArcGIS License 
Server Administrator), you can see that when a user has opened ArcGIS Pro 
with an Advanced license, that license is no longer available to other users 
until ArcGIS Pro is closed. But a user could use ArcGIS Pro with one of the 
Basic or Standard licenses available on the license manager in this example.
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How to set up an ArcGIS Online organization account

To authorize ArcGIS Pro with a Named User license, you must be a member of an ArcGIS 
organization. 

1  	 Activate the account
When you purchase a license for ArcGIS or start a trial, the person who requested a 
subscription should have received an email with an activation link from the ArcGIS Online 
accounts team. The email will look like this:

The subscription must be activated by the person who will administer the ArcGIS Online 
organization. If necessary, have the email forwarded to the appropriate person. Click the link 
and follow the steps to activate the account. 

2  	 Need your ArcGIS Online activation code?
If you determine that you have not activated your ArcGIS Online organization account and you 
can’t find the activation email that was sent to you, go to the Need your ArcGIS Online 
activation code? section near the bottom of this landing page. The section looks like this:

http://www.esri.com/landing-pages/arcgis-desktop-entitlement
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3  	 Add members to your organization
As the ArcGIS Online organization administrator, you will need to assign ArcGIS Pro Named 
User licenses to other users. These users must first be members of the organization.

When signed in to the organization as Administrator, from the 
Organization tab, invite users to your organization by clicking 
INVITE MEMBERS. 

The Add or Invite Members wizard gives you three options.

The quickest option is to choose Add members without sending invitations. With this 
option, you set up the user name and password for each member. You must inform the 
members of their user names and passwords. More details about the other ways of adding 
members to the organization can be found in the Invite and add members help. ArcGIS Pro 
requires that members have a level 2 license.

Once the member is added, follow the Named User with ArcGIS Online organization workflow 
to assign an ArcGIS Pro license.

http://doc.arcgis.com/en/arcgis-online/administer/invite-users.htm
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Troubleshooting FAQ

I have installed ArcGIS Pro but I am not an organization administrator and do not have 
the Manage Licenses privilege.

You will need to ask an organization administrator to assign a license to you. Administrators 
who are not familiar with the process can use this guide to find the Authorize ArcGIS Pro 
section.

ArcGIS Pro tip
If you don’t know who the administrator is, sign in to your ArcGIS Online organization account, 
click the Home tab, and click the Contact Us link at the bottom of the page. If the 
organization’s administrator has enabled that setting, you can send an email to request an 
ArcGIS Pro license by clicking that link. 

If you do not know the administrator and no contact details have been provided, click the 
Organization tab and look for a user with the Administrator role.

In the example below, ArcGISPro_User is signed in—by clicking the Organization tab, the user 
can see the name of the person with the Administrator role. This tip should help you get in 
touch with the administrator so that an ArcGIS Pro license can be assigned to you.

If you are still unable to determine who the ArcGIS Online organization administrator is, you 
will need to contact Esri Customer Service for assistance.

http://www.esri.com/about-esri/contact
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What if I get an error when trying to sign in to ArcGIS Pro?

If you get the message “Invalid username or password” on the dialog box, click Forgot 
password? or Forgot username? to resolve the issue.

If the error message is “This account does not have an ArcGIS Pro Named User license 
assigned”. . .

. . . it is because you are trying to sign in either with a user name for a public account (which 
cannot authorize ArcGIS Pro—see the ArcGIS public account section for help), or without your 
having been assigned a license by your ArcGIS administrator.
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ArcGIS Pro tip
To ensure that your user name is associated with an organization account, you can go to 
arcgis.com and sign in. If the page shows you as being signed in but the URL is  
www.arcgis.com/home/index.html, you’re using a public account, which can’t be used to 
license ArcGIS Pro. See the ArcGIS public account section for help.

If you sign in to arcgis.com and the URL includes your organization name (it will look like 
www.<orgname>.maps.arcgis.com/home/index.html), then you’ve confirmed that your user 
name is linked with an organization account. If you’ve confirmed that you are part of an ArcGIS 
Online organization but you are getting a sign-in error message, see this ArcGIS Pro tip to 
learn how to contact your administrator and have an ArcGIS Pro license assigned.

ArcGIS public account
ArcGIS Pro Named User licenses are managed through ArcGIS Online organization or ArcGIS 
Enterprise accounts, not public accounts. Here are your options:

•	 It’s possible that your organization has set up either Single Use or Concurrent Use 
licensing for ArcGIS Pro. If this is the case, check with your GIS administrator to get 
an authorization code for a Single Use license, or the name of the license manager 
to authorize using a Concurrent Use license.

•	 Sign up for a free ArcGIS trial.
•	 Purchase an ArcGIS Desktop license.

http://www.arcgis.com/home/index.html
http://www.esri.com/en/arcgis/products/arcgis-pro/trial
http://www.esri.com/en/arcgis/products/arcgis-pro/buy-now


23

Additional resources

Get started with ArcGIS Pro

Download and install ArcGIS Pro
System requirements
Download and install

Authorize ArcGIS Pro
About licensing
License levels
ArcGIS Pro license types
	 Named User licenses
		  Configure ArcGIS Pro licenses for your organization (ArcGIS Enterprise)
		  Provision ArcGIS Pro licenses in ArcGIS Enterprise portal
		  Connect to the licensing portal in ArcGIS Pro
	 Single Use licenses
	 Concurrent Use licenses
		  Installing the license manager

How to set up an ArcGIS Online organization account
Activate subscription
Invite and add members
Levels, roles, and privileges
Manage licenses (ArcGIS Online)
Manage licenses (ArcGIS Enterprise)

Copyright © 2017 Esri. All rights reserved. Esri, the Esri globe logo, ArcGIS, The Science of Where, @esri.com, and esri.com are trademarks, service marks, or registered marks of Esri in the United States, the European Community, or certain other jurisdictions. Other companies and 
products or services mentioned herein may be trademarks, service marks, or registered marks of their respective mark owners.

G79489

http://pro.arcgis.com/en/pro-app/get-started/get-started.htm
http://pro.arcgis.com/en/pro-app/get-started/arcgis-pro-system-requirements.htm
http://pro.arcgis.com/en/pro-app/get-started/install-and-sign-in-to-arcgis-pro.htm
http://pro.arcgis.com/en/pro-app/get-started/about-licensing.htm
http://pro.arcgis.com/en/pro-app/get-started/license-levels.htm
http://pro.arcgis.com/en/pro-app/get-started/licensing-arcgis-pro.htm
http://pro.arcgis.com/en/pro-app/get-started/named-user-licenses.htm
http://server.arcgis.com/en/portal/latest/administer/windows/configure-arcgis-pro-licenses.htm#ESRI_SECTION1_B534D464350F43FDA277B746F1E6EF36
http://server.arcgis.com/en/portal/latest/administer/windows/configure-arcgis-pro-licenses.htm#ESRI_SECTION1_87DAA797B12D43F199C09A1B993D53D4
http://server.arcgis.com/en/portal/latest/administer/windows/configure-arcgis-pro-licenses.htm#ESRI_SECTION1_4A1E11A6BB4540C68929AB44C0DFEF00
http://pro.arcgis.com/en/pro-app/get-started/single-use-licenses.htm
http://pro.arcgis.com/en/pro-app/get-started/concurrent-use-licenses.htm
http://desktop.arcgis.com/en/arcmap/latest/get-started/installation-guide/installing-the-lm.htm
http://doc.arcgis.com/en/arcgis-online/reference/activate-subscription.htm
http://doc.arcgis.com/en/arcgis-online/administer/invite-users.htm
http://doc.arcgis.com/en/arcgis-online/reference/roles.htm
http://doc.arcgis.com/en/arcgis-online/administer/manage-licenses.htm
http://server.arcgis.com/en/portal/latest/administer/windows/manage-licenses.htm

